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Chapter 1  Getting Started 

Overview 
The Windows Servo Design Kit (WSDK) software will walk you through set-up, configuration, tuning, 
testing and analysis of your Galil Motion Controllers.  There are two versions of this software for use 
with the different Windows environments.  WSDK16 is for Windows 3.1 and 3.11, and WSDK32 is 
for Windows 95,98, NT, ME, XP and 2000.  

WSDK has a number of functions that simplify and aid in setting up and evaluating a complete servo 
system.  The subjects that will be addressed in this manual are: 

 
• Setting Up Communications 

• Tuning Servo Systems 

• Monitoring and Recording Data using the Storage Scopes 

• Evaluating System Performance 

• Configuring System Parameters 

• Accessing System Information 

• Diagnosing Problems 

• Creating a Motion Profile 

• Sending Commands Directly to the Controller Using the Terminal 

• Editing, Uploading and Downloading Application Programs Using the Editor 
 

Each of the Servo Design Kit options will display a different form.  The available menu items will vary 
from one form to the next.  Every form has a Terminal menu item from which you may communicate 
directly with the controller.  The terminal is described in Chapter 9.  Every form also has an Exit menu 
item which, when clicked, will return you to the main form. 
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Running WSDK 
Double click on the WSDK icon created during the installation process.  The main window, pictured 
below, will appear.  Use this window as a starting point to all the functions within WSDK.   

 

 

Register the Controller 
In order to communicate with your Galil controller, you must first register it in the Windows registry.  
The Windows registry is a central repository of configuration information concerning all hardware that 
is installed on your system.   Once registered, the Servo Design Kit program can then communicate 
with the controller.   

To register a controller, use the File menu item “Register Controller” (located on the main form only), 
and the following window will appear: 
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From this window, the user may add, change and delete registry information.  To change registry 
information, highlight the controller and click the button "Properties".  To add a controller, click the 
“New Controller” button to get to the following window:  

 

 
 

To register a controller, first select the model of your controller.  Then enter the appropriate parameters 
for that controller.  For example, for a DMC-1700, you must select an I/O port address and optionally 
an interrupt (IRQ).  These parameters can be accessed under the tab "ISA Bus Parameters".  For a 
DMC-1500, you must select the Comm Port and Comm Speed, which can be found under the tab 
“Serial Parameters".  

Note: Hardware handshake should always be enabled for the DMC-2000 (serial communication).  
This is done by setting the HSHK dip switch to 'ON' on the DMC-2000 (serial communication).   

Unless otherwise instructed by Galil, leave the Timeout and Delay parameters set to their default 
values. 
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Once you have entered all the necessary parameters, click the “OK” button to save the registry 
information.  You may need to close the Servo Design Kit program and re-boot your system in order 
for the configuration changes to be recognized by the system.  You only need to register your 
controller one time, as the information is stored in permanent registry. 

Connect to Controller 
Once you have registered your controller in the Windows registry, you may communicate with it.  Use 
the File menu item "Connect to Controller" to open a communications session with your controller.  If 
you have more than one controller registered, the Servo Design Kit program will display a window 
from which you may select a controller.  Highlight the controller that you want to connect using the 
mouse or keyboard, and then click the OK button.  You may also double-click on the controller in the 
list box to connect immediately. 

Note: You may have to reboot your Windows system in order for the system to recognize changes made 
to the Windows registry.  If you are unable to communicate with your controller after registering it, 
reboot your system. 

Interrogate the Controller 
To insure that the controller is working properly, you may use the terminal to send simple interrogation 
commands.  The terminal can be accessed from any of the windows in WSDK by simply selecting the 
Terminal menu at the top of the screen.  To test for proper communication: 

1.  Place the cursor at the command line. 

2.  Press the Enter key - the controller should respond with a colon (:). 

3.  Input the command, <CTRL> R <CTRL> V and press the enter key.  The controller will respond 
with revision information about your controller. 

 

A figure on the next page illustrates the result of a communication test done on a DMC-1500. 

There is a list of additional interrogation commands described in the controller's user manual.   

For additional information about the terminal, see Chapter 9, Terminal & Editor.   
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Chapter 2  Tuning Methods 

Overview 
When operating a Galil Motion Controller with servo motors, the system parameters for each axis must 
be established to provide optimal servo operation.  The main parameters to be determined are: KD, KP 
and KI.  These parameters are associated with the PID transfer function described in the theory section 
of the controller's user manual.  The parameters for optimal system performance can be determined 
manually or automatically through the tuning section of the WSDK software.  The tuning effect on 
your system’s performance can be monitored on the scope provided. 

The user can choose from 6 different tuning methods: Auto Crossover Frequency, Crossover 
Frequency, General Tuning, Conservative Tuning, Point to Point Tuning and Manual Tuning.  Each 
method approaches the tuning process in a different way and may, therefore, give different results.  If 
one type of tuning does not provide acceptable performance, try another one.  If any routine provides 
suitable values (of KD, KP and KI), there is no need to continue with further auto-tuning routines.  

Along with the tuning methods, a step response test may also be performed in order to evaluate the 
response of the system.  The test displays the actual position of the motor as a function of time.  
Typically, a well-tuned motor would result in a slight overshoot on the trailing edge and then quickly 
settle.  The step-response test can be performed by not checking the “Perform Tuning Test” box, and 
then clicking on the “Start Test” button. 

Note: The most effective procedure is to first use an auto-tuning method, followed by using the manual 
tuning method to adjust the parameters for optimal performance. 

Tuning Methods 
The following six tuning methods are available.  A box located below the menu bar will display a brief 
explanation of the selected tuning method. 

Automatic Crossover Frequency  
Crossover frequency, which is measured in units of radians/second, is defined as the maximum 
frequency to which a system can respond without a loss of gain.  The Auto Crossover Frequency 
routine attempts to determine the PID parameters that correspond to this maximum frequency.  Use 
this automatic tuning routine if the bandwidth of the system is unknown.   

See picture on next page. 

Note: This tuning method will not work with amplifiers set in the velocity mode. 
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Crossover Frequency 
The Crossover Frequency routine will let you define a crossover frequency (rad/sec), and then attempts 
to tune the axis to provide the best system response at that frequency.  The value of the crossover 
frequency should be set to the bandwidth of the system for best results.  

You can choose a frequency between 5 and 650 rad/sec.  Lower frequencies tend to cause over-
damping in the system, resulting in a slower and more sluggish response.  Higher frequencies produce 
faster system response, but because it tends to under-damp, it may cause the system to overshoot. 

Note: This tuning method will not work with amplifiers set in the velocity mode. 

General Tuning   
The General Tuning routine is best suited for velocity mode amplifiers, although it will work for 
systems with various types of drives and amplifiers.  This routine tunes the system by increasing the 
gain until instability occurs, and then backs the gain down.  In this test, WSDK finds the best KP for a 
given value of KD.  Once the best KP is found, KD is increased and WSDK finds the best KD again.  
This process is repeated until KD cannot be increased further without causing instability in the system.  
WSDK then decreases KP and KD to stable values.  At the last step, WSDK determines the highest 
stable value for KI. 
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Conservative Tuning   
The Conservative Compensation routine will try to find a gain setting that won't cause 'buzzing' or 
overdrive your system.  As the name suggests, the PID parameters are chosen to avoid any instability 
in the system and still provide a responsive system.  The resulting parameters are very conservative but 
will provide an operational system.   

This tuning method has two-parts, both using an algorithm similar to that used in the general tuning 
method.  The first part is a "static" test, and the second part is a "dynamic" test.  In the static test, the 
system gain is increased, while being excited with a small impulse.  Once the system looses stability, 
the gain is backed down and the results are shown.  In the dynamic test, the system gain is increased 
while movement is occurring.  Once the system looses stability, the movement is stopped, and the gain 
is backed down. 

Point to Point Tuning 
This tuning method allows the user to define “settling.”  The user specifies the error limit and time for 
which the system must stay within those limits.  The program then iterates through the PID parameters 
within the specified range to determine which combination results in the fastest settling time.  The 
larger the error limit and the shorter the time the system must stay within those limits, the faster the 
settling time.   

Note: The amount of time this method will take depends on the number of iterations it must g o through.  
To find the optimal PID parameters without iterating through the unnecessary combinations, use one 
of the auto-tuning methods to estimate the range of PID values and then, use this method to fine tune 
the PID parameters. 

Manual Tuning  
The Manual Method will let you choose the gain and damping on your system.  Unlike the other tuning 
methods, this is not an auto-tuning routine.  All tuning parameters can be adjusted with sliders.  
Whenever the values are changed, the new values are sent to the controller.  This gives instant 
feedback regarding the effect of each parameter on the stability of the system.  Manual tuning provides 
a means of testing the responsiveness of your system.  This tuning method uses the step response, to 
show effects of changes made to the PID filter.  The gain parameters can be changed by clicking on the 
sliders or by typing in new values in the appropriate box.  You can change the step response 
parameters by clicking on the “Step Response Parameters” option under the Edit menu.  To try out new 
values for KP, KD, and KI, click on the Start Test button. 

Running the Tuning Methods 
Before executing any tests, you must select a tuning method and the axis to be tuned.  You may also 
select to show a step response based on the current PID filter settings.  The step response provides a 
visual indication of how well your system is tuned.  To begin the tuning procedure, click on the “Start” 
button. 

Note: A Step Response test may be performed by not checking the “Perform Tuning Test” box.  The 
actual position will be displayed for the user to analyze without changing the tuning parameters. 

Editing Tuning Parameters 
From the Edit Menu, the user may adjust parameters used in the tuning procedures.  These parameters 
include: 

§ Crossover Frequency Tuning Parameters 
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§ General Tuning Parameters 

§ Point to Point Parameters 

§ Step Response Parameters 

Crossover Frequency Tuning Parameters 
The Auto Crossover Frequency and Crossover Frequency tuning methods both start the procedure by 
sending a pulse or offset to the axis at a specified voltage and duration.  The values of the Pulse 
Magnitude (Volts) and the Pulse Duration (milliseconds) can be changed through the Edit menu.  
These values can be changed by typing them in or by using the slider provided.  When finished, click 
the OK button to return to the previous screen.  If you wish to save these values permanently, click the 
Save button.  If you wish to restore the values to their defaults, click the Defaults button.  If you don't 
want to keep the changes you made, click the Cancel button. 

General Tuning Parameters 
The general tuning method uses a step pulse to determine the system response to different values of the 
PID parameters.  For systems with very high or very low encoder resolution, the size of this step may 
need to be adjusted.  For systems with a very high-resolution encoder, the default step size may not be 
large enough to adequately move the motor to determine proper system response.  Increase the step 
size to rectify the problem.  For systems wi th very low encoder resolution, the standard step size may 
be too large and cause excessive motor motion during the tuning procedure.  In this case, the step size 
would need to be decreased.  The step size should only be adjusted under these extreme conditions and 
will otherwise, make no difference to the tuning procedures.  The step size will be reset to the 
standard/default size of 500 counts whenever WSDK is re-started. 

Point to Point Tuning Parameters 
Details of the motion profile used in this tuning method are shown in this parameter window.  The 
distance, speed, acceleration and deceleration values may be changed by typing in the new values or by 
using the slider provided.  The “Window Size,” which defines ‘settling,’ may be designated by 
entering a new value for the error limit/tolerance (counts) and a value for the length of time the system 
must remain within those limits. 

Other limits may also be set for this tuning method.  For example, the maximum voltage contribution 
by the KI factor can be defined by entering a value for the “Integrator Limit,” thus altering the current 
limit of the integrator in the control loop.  The range of PID parameters that the tuning routine iterates 
through, and the increments at which it will iterate by, may also be designated here.  The amount of 
time (milliseconds) that the program will wait for the system to settle before aborting the test  (Time-
out) can be entered. 

Step Response Parameters 
This window allows the user to change the values used for displaying the step response.  You can 
change any of the following items:  Dwell Time, Step Size, Acceleration, Deceleration, and Maximum 
Speed, as well as some display options.  You can either type in new values or use the sliders to change 
the values.  When you are done, click the OK button to return to the previous screen.  If you wish to 
save these values permanently, click the Save button.  If you wish to restore the values to their 
defaults, click the Defaults button.  If you do not want to keep the changes you made, click the Cancel 
button. 
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Chapter 3  Storage Scopes 

Overview 
The storage scope provides a method to record the actions of your controller and display them on the 
screen.  To record the controller's actions, you must first select the type of data you want to record.  
This is done with the various combo-boxes.  It is also possible to display the derivative of a data you 
have recorded.  For example, if you want to see velocity, you could select Actual Position as the data 
type and then select Derivative.  This option defaults to Normal.  If you wish, you can save or print the 
storage scope data. 

To use the scopes, follow these simple steps: 

• Select “Storage Scope” from the main window 

• Select the number of scopes to display (1 through 4) 

• From the lists provided, set the data to be displayed 

• Click on the Terminal menu to bring up the terminal 

• Type in a single move or entire program (see Chapter 9 – Terminal & Editor) 

• Return to the storage scope and execute the motion via the “Command String.”  At the same 
time that this string is sent, data collection will begin to make sure data collection is 
synchronized to the start of the motion.  

• Click on the “Start Collecting” button to gather and display the information 
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Selecting Storage Scopes 
You may customize the appearance of the storage scope in various ways:  turning grid lines on or off, 
display data values or not, choice of showing minimum and maximum values, and changing Data 
Colors.  Access these Storage Scope Parameters by going to the Edit menu.  To switch between storage 
scope options, click on the desired tab at the top of the screen just below the menu bar. 

Single Storage Scope 
This screen provides a single storage scope that can display two traces.  To record the controller's 
actions, you must first select what type of data you want to record.  This is done with the combo-boxes. 
The data type defaults to Actual Position.  If you want to record two axes in coordinated motion, select 
which two axes to record.  The axis selection combo-box is near the upper right corner.  It defaults to 
X Axis Vs. Time. 

It is also possible to display a derivative of the data you have recorded, as mentioned earlier in the 
overview.  That is, if you want to see velocity, you could select Actual Position as the data type and 
then select Derivative.  The default is Normal. 

If you want to have two traces on the screen, select Collecting for Secondary, followed by selecting the 
axis and data types.  When you have set up all the collecting combo-boxes, make sure the “Command 
String” has the correct starting command for the program loaded in the controller.  Click the “Start 
Collecting” button to get and display data on the scope. 
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Multiple Storage Scopes (2,3 and 4 Scopes) 
These screens provide two, three, or four storage scopes.  To record the controller's actions, you must 
first select what type of data you want to record.  This is done with the combo-boxes. The data type 
defaults to Actual Position.  Each scope is capable of recording and displaying a different type of data. 

It is also possible to display a derivative of the data you have recorded.  If you wanted to see velocity, 
you could select Actual Position as the data type and then select Derivative.  The default is Normal. 

Continuous Storage Scope 
This screen provides a continuous storage scope.  Although not quite real-time, the continuous storage 
scope does provide continuous recording and displaying of data.  On slower systems, the scope period 
may have to be set higher than the default 4 milliseconds, otherwise, data points may be lost. 

To record the controller's actions, you must first select what type of data you want to record.  This is 
done with the combo-boxes.  The data type defaults to Actual Position. 

It is also possible to display a derivative of the data you have recorded.  For example, if you want to 
see velocity, you could select Actual Position as the data type and then select Derivative.  The default 
setting is Normal. 

The maximum and minimum values to display on the graph can be adjusted at any time (even when the 
scope is active) by typing in new values or by using the spin buttons. 

A trigger may be set by clicking on the “Trigger On” check box and adjusting the minimum and 
maximum trigger values.  The continuous storage scope will stop whenever a recorded value is less 
than or equal to the minimum trigger value, or greater than or equal to the maximum trigger value.  
When the continuous storage scope stops due to a trigger condition, the trigger value is highlighted by 
means of a vertical line on the graph. 

Storage Scopes Options 

File Menu 

Download File 
This option allows the user to download a file directly to the controller.  When selected, WSDK will 
present a file selection window for the user to select the file to be downloaded. 

Save Scope Data As 
This option allows the user to save the storage scope data points into a text file.  For a single scope, 
each sampled value is separated by a carriage return line feed.  For multiple storage scopes, the data 
points for each scope are separated by a comma, and each sample period is separated by a carriage 
return line feed.  

Print and Printer Setup 
These options allow the user to print the current storage scope window and specify printer information. 
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Edit Menu 

Storage Scope Parameters 
The user may customize the parameters used for data recording.  The total number of points recorded 
and the period between each point may be specified here.  The values can be changed by entering the 
new value or by using the slider.  When finished, click the “OK” button to return to the previous 
screen.  To save these parameter values permanently, click the “Save” button.  To restore the default 
value, click “Defaults”.  To discard the changes made, click “Cancel.” 

Note:  When more than one trace is being displayed, the number of data points will be equal to the 
total number of points used for all traces.  For example, if you are using 4 storage scopes and 8000 
data points have been selected, each trace will consist of 2000 data points. 

Graph Menu 

Show Grid 
Allows the user to turn the scope grid on or off. 

Show Values 
Allows the user to show values on the axes.  The unit for time is in milliseconds.  Position units are 
encoder counts for servo motors and step pulses for stepper motors.  The unit for torque is volts. 

Show Minimum and Maximum 
Allows the user to graphically display the minimum and maximum values on the scope. 

Data Colors 
This window allows you to change the color of any of the four scope traces.  The only time you will 
see four traces at the same time will be in the Storage Scope with 4 windows.  Be sure to set the trace 
colors to something that will be easy to see. 

Storage Scope Zoom 
This feature is accessed through the “ZOOM” button on the storage scope window.  It allows the user 
to zoom in on a portion of the storage scope graph.  As you move the mouse over the graph, you will 
notice that the actual X and Y coordinates are tracked and displayed above the graph.  To zoom in on a 
portion of the graph, hold down the left mouse-button and drag the mouse.  As you drag the mouse, 
you will notice a rectangular area will form (denoted by a dotted line).  The area inside this rectangle 
will be expanded to the size of the entire graph when you release the left mouse button.  To zoom out 
from a position, click the “Zoom Out” button.  To restore the graph to its original perspective, click the 
“Fit Data” button. 
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Chapter 4  System Evaluation 

Overview 
Once the tuning is complete, the system should be ready for operation.  WSDK provides a section on 
System Evaluation, which allows the user to check the response characteristics of the system.  This can 
in fact be done in several ways: 

• Use the auto-graphing feature contained in each tuning procedure 

• Use the storage scope function and design a custom test 

• Use the System Evaluation section of WSDK 

It is probably worthwhile to try all of the three methods to ensure proper evaluation of the system’s 
response.  The first method relies on the step response, which is displayed as part of the tuning 
procedure.  The second method requires that the user write a program, run it, and evaluate the system 
response by comparing the actual profile to the commanded profile on the storage scope (details of 
Storage Scope usage for this evaluation is described in Chapter 3).  The third method involves the 
System Evaluation section of WSDK to run standard tests to evaluate the system’s performance. 

System Evaluation Tests 
There are three system evaluation tests that can be performed from the System Evaluation section of 
WSDK.  A brief explanation of each test is also displayed in a box below the option tab. 

Absolute Stability Test 
The Absolute Stability test saturates the system to determine if it is conditionally unstable.  The system 
is subjected to a pulse at the maximum output voltage of the controller (10V).  If no instability is 
found, the system will remain stable unless under extreme or unusual conditions.  Generally, this test 
of conditional stability is more common when the integration term, KI, is being used as part of the 
filter.   

The test displays the actual position (responding to an impulse) and the requested torque on two 
separate scopes.  Typically, a well tuned system will generate a position profile that consists of a single 
overshoot on the trailing edge.  Excessive ringing on the trailing edge is a sign of instability and 
reveals that the PID parameters are not optimal.  If the position profile shows no overshoot, the system 
is over damped.  In this case, the system is not tuned for the maximum bandwidth. 

The Requested Torque graph allows the user to determine whether the impulse size needs to be 
adjusted for the test.  If the requested torque goes to the maximum value of 10 volts, the controller is 
saturated and will not reflect proper test results.  If the requested torque is too small (less than 1 volt), 
the impulse response may not have detected the instability within the system.   
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Frequency Response on Open Loop 
This test will provide a graphical look at the responsiveness of your system by analyzing the open-loop 
frequency response of the system.  The actual position (green trace) and positional error (blue trace) 
are plotted in the upper scope.  The lower scope displays the system gain as a function of frequency.  
This data can aid the user in determining whether further tuning or refining of the system is necessary.  
The axis to be tested may be selected by clicking on the Axis combo box.  The starting and ending 
frequencies for the test may be adjusted through the "Frequency Response Parameters" item under the 
Edit menu. 

 

 

Frequency Response on Closed-Loop  
This test will perform an analysis of the closed-loop frequency response of your system.  Like the 
open-loop test, the actual position (green trace) and commanded position (blue trace) are plotted in the 
upper scope.  The lower scope displays the system gain as a function of frequency.  This data can aid 
the user in determining whether further tuning or refining of the system is necessary.  The axis to be 
tested may be selected by clicking on the Axis combo box.  The starting and ending frequencies for the 
test may be adjusted through the "Frequency Response Parameters" under the Edit menu item.   

Step Response Test 
This test is part of the tuning procedures and can be found on the “Tuning Methods” section.  This test 
will display the actual position so the user can determine whether further tuning or correction to the 
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system is necessary.  To perform a Step Response test without changing the tuning parameters of your 
system, select any tuning method and make sure the “Perform Tuning Test” check box is unchecked. 

Editing Test Parameters 

Absolute Stability Test Parameters 
The parameters for the Absolute Stability Test may be changed through the Edit menu.  The Pulse Size 
and Pulse Time (duration) may be adjusted for each test by entering a new value or using the slider.  
Once finished, click the “OK” button to return to the previous screen.  To save the values permanently, 
click on “Save”.  To restore the default values, click on “Defaults”.  To discard changes made, click 
the “Cancel” button. 

Frequency Response Parameters 
The Frequency Response Parameters may be changed through the Edit menu as well.  The Amplitude, 
Frequency Step, Starting Frequency and Ending Frequency can be changed by entering a new value in 
the dialog box or using the sliders.  When done, click the “OK” button to return to the previous screen.  
To save the values permanently, click on “Save”.  To restore the default values, click on “Defaults”.  
To discard changes made, click the “Cancel” button. 

 

 



18  •  Chapter 4  System Evaluation Windows Servo Design Kit 

 

 

 

 

 

 

 

 
This Page Left Blank Intentionally 

 



Windows Servo Design Kit Chapter 5  System Information  •  19 

Chapter 5  System Information 

Overview  
This form displays controller status information such as current position, error, and state of the inputs 
and outputs.  The information is organized by “Axis Information” and “General Information.”  Click 
the tab located directly beneath the menu bar to switch between the two forms. 
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Edit Menu Options 
The following options can be accessed through the pull-down menu item, "EDIT". 

Refresh Display 
This option will update the display with the current system information. 

Continuous Refresh 
This option will refresh the system information continuously.  This can be very useful for monitoring 
the system.  The default refresh rate is approximately 100 milliseconds.  To stop the continuous 
display, select the “Continuous Refresh” item again (the check mark will disappear). 

System Information Parameters 
The “Refresh Rate” value for the Continuous Refresh utility may be changed via this window.  The 
value may be changed by typing in a new value or by using the slider.  When finished, click on “OK” 
to return to the previous screen.  To save the changes permanently, click the “Save” button.  To restore 
the default values, click “Defaults”.  To discard changes, click on “Cancel.” 
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Chapter 6  Set-up & Configuration 

Overview 
The “Set-up and Configuration” form allows the user to display and/or edit the set-up parameters for 
your Galil Motion Controller.  The set-up parameters are those variables that are saved in the non-
volatile memory (EEPROM) of the controller when the burn (BN) command is executed.   
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File Menu Options 

Open DMC File 
This command allows the user to open a previously saved DMC file.  A DMC file has all of the set-up 
information and can be useful for restoring a system to a specific setup configuration; DMC files have 
the .DMC extension. 

Save DMC File; Save DMC File As 
This command will save the current set-up parameters on the controller to a DMC file.  Once a 
controller is set up, it is highly recommended that a DMC file be created.  This DMC file can be used 
to restore the system in cases where setup information gets inadvertently changed.  DMC files have the 
.DMC extension. 

Print 
The print command will print the current display. 

Exit 
This command will exit the current form and return to the main form. 

Edit Menu Options 

Get Parameters 
This command will retrieve all the set-up parameters from the controller.  This command is executed 
automatically when the Set-Up and Configuration form is first displayed and after the Reset Controller 
and Master Reset Controller commands have been executed. 

Set Parameters 
This command will send all the set up parameters displayed on the screen to the controller and then 
will execute the burn (BN) command to save the set-up parameters in the non-volatile memory 
(EEPROM) of the controller. 

Clear 
This command clears the set-up parameters display.  To view the current set-up parameters, use the 
“Get Parameters” command. 

Reset Controller 
The “Reset Controller” command resets the current state of the controller to its power-on condition.  
The previously saved state of the controller, along with the set-up parameter values and saved 
sequences, are restored. 
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Master Reset Controller 
The master reset command resets the set-up parameters of the controller to the factory default settings 
and erases the non-volatile memory (EEPROM). 
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Chapter 7  Diagnostics 

Overview 
Using the “Diagnostics” form, a user can further diagnose the system by testing it under various 
conditions to determine if the system has any problems.   
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Tests 
The following three tests are available.  Once a test is selected, a brief explanation will be displayed in 
a picture box located below the test option tab. 

Static 
This test allows the user to diagnose the system without causing any disturbances.  It collects data and 
reports any anomalies that may affect the system’s performance.  The diagnosis is displayed under 
“Test Results.” 

Dynamic 
This test subjects the system to a pulse and calculates its dynamic response.  It will respond with 
whether the system is under-damped, over-damped or unstable.  Note that this test will attempt to 
move the motors, thus disturbing your system during the process. 

Gain 
This test calculates the overall gain of the amplifier, motor and encoders by subjecting the system to a 
pulse.  Note that this test will attempt to move the motors, thus disturbing your system during the 
process. 

Editing Test Parameters 
Two options are available under the “Edit” menu to specify the parameters for the test: 

Dynamic Test Parameters 
The magnitude and duration of the pulse used for the dynamic test may be changed by entering a new 
value or by moving the slider.  To save the parameters permanently, click on “Save.”  To return the 
parameters to the default values, click on “Defaults.”  To return to previous screen after changing the 
values, click on “OK.”  To discard the changes made, click on “Cancel.” 

Gain Test Parameters 
The same parameters described above can also be adjusted for the gain test. Apply the instruction 
above to the “Gain Test Parameters” edit menu item in order to change the magnitude and duration of 
the pulse for the gain test. 
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Chapter 8  Motion Profile Builder 

Overview 
In the “Motion Profile Builder” form, a user can define the constraints and/or requirements that the 
program uses to generate a point-to-point motion profile, which is downloadable to the controller.  
Picture below shows an example of this form when selected from the WSDK main window. 
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Select Design Method 
The following three methods are available.  Once a method is selected, a brief explanation will be 
displayed in a picture box located below the menu bar. 

Encoder Counts 
The user specifies the axis, distance in counts, speed, acceleration and deceleration.  The program will 
check if the specified speed is possible with the given acceleration, deceleration and distance values.  
Otherwise, the speed will be adjusted to a lower value.  The program then displays the calculated 
motion profile and the generated program (code).  To download this program to the controller, click on 
“Download Program.” 

Physical Quantities 
This option converts the physical quantities entered by they user into units of encoder counts.  The user 
specifies the axis, encoder resolution, distance, speed, acceleration and deceleration.  It allows the user 
to designate whether the system is linear or rotational.  In the case of a rotational system type, the 
parameters may be entered in counts or rotational units, such as radians of rotation and RPM.  In the 
case of a linear system, the parameters may be entered in counts, English units or Metric units.  In 
either case, clicking “Calculate,” after the values of the parameters have been entered, will convert the 
units and generate the motion profile. Clicking “Show Results” will display this motion profile and the 
generated code.  To download this code/program to the controller, click on “Download Program.” 

Optimal Design – Minimum Power Dissipation 
This option is the same as the Physical Quantities option, except that rather than actual speed and 
acceleration, the user specifies their limits.  Clicking on “Calculate” will display the speed and 
acceleration/deceleration values that minimize power dissipation to the motor.  To display the 
calculated motion profile and generated program (code), click on “Show Results.”  To download this 
program to the controller, click on “Download Program.” 
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Chapter 9  Terminal & Editor 

Overview 
A terminal screen is included in the WSDK program.  It is used to send commands to the controller 
and display the controller’s response.  This tool provides a direct link to the controller, allowing simple 
programming and interrogation.  The terminal can be accessed from any of the windows in WSDK by 
selecting “Terminal” on the menu bar. 

To send a command to the controller, type inside the single-lined text box located directly below the 
menu bar, followed by clicking on “Send.”  Once executed, the commands will appear on the terminal 
screen beneath the text box.  To clear this screen, click on “Clear” at the bottom of the screen. 
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File Menu  
The following File Menu items are available:  

Download File 
This command will download the specified file to the controller program memory.  The user will be 
queried for the filename. 

Upload File 
This command will upload the contents of the controller’s program memory into a file.  The user will 
be queried for the filename. 

Send File 
This command will send the contents of a file, one command at a time, to the controller.  The 
controller will wait between each command for a response from the controller before sending the next 
command.  When sending file, the commands sent to the controller and also the controller’s responses 
will be echoed on the terminal screen for your reference.   

Note:  This command is equivalent to inputting commands at the terminal command line.  A program 
cannot be executed by using this program and therefore, certain commands are invalid when inserted 
into a send file.  An error in the send file will halt the send command.  The default extension for send 
files is *.SEN. 

Options Menu 
The following Options Menu items are available:  

Get Version 
This option displays the WSDK version, the controller type and number of axes, and the controller’s 
firmware revision number. 

 

 

Set Timeout 
When a command is executed from the terminal command line, the terminal waits for a response from 
the controller.  This response, also known as a prompt, is either a colon or a question mark.  A colon is 
returned when the controller has properly executed the command and is prepared for the next 
command.  A question mark is returned when the last command resulted in an error and the controller 
is prepared for the next command.  The user can determine the cause of the controller error by using 
the tell error code command, TC1. 
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If the terminal does not detect a response from the controller, it will alert the user with an error 
message.  The amount of time that the controller waits for a response is the timeout value.  The timeout 
value can be changed with the Set Timeout Value option.  This value is in units of milliseconds and 
has a default value of 1000.  The value can range from 0 msec to 86400000 msec, and a value of 0 
msec will turn off the timeout value.  The value of the timeout will always be reset to 1000msec when 
WSDK is re-started. 

Note:  When a timeout has occurred, the terminal program will respond with the following error, "A 
timeout error occurred while waiting for a response from the controller."  This warning alerts the user 
that the controller did not respond to a command within the timeout period.  This can happen under 
several conditions, such as when the burn command, BN, is given.  When the BN command is executed, 
the controller can take up to 2 seconds to return a response.  Since this is longer than the default 
timeout value of 1 sec (1000 msec), the terminal will respond with this warning.  This warning can be 
ignored under this condition.   In addition, under certain conditions, the controller may not always 
respond with a prompt at the command line.  For example, this may happen if the controller is 
executing a program that contains the input command, IN.  When the IN command is issued (from 
within a program), the user must enter an input.  When this is done, the terminal will expect a prompt, 
but the controller will not return a prompt as a response to the command IN.  This will cause the 
timeout warning and should be ignored. 

Reset Controller 
The Reset Controller option resets the state of the controller to its power-on condition.  The previously 
saved state of the controller, along with the set-up parameter values and saved sequences are restored. 

Master Reset Controller 
The master reset command resets the set up parameters of the controller to the factory default settings 
and erases the non-volatile memory (EEPROM). 

Update Flash EEPROM 
When selected, this option will update the controller with the latest firmware version, which may be 
downloaded from Galil’s website, www.galilmc.com.  The controller will query the user for the 
location of the firmware file, which has extension *.hex. 

Note: This Flash EEPROM update function may not be used with the Legacy Series DMC-13X8, 
DMC-1410, DMC-1411, DMC-1412, DMC-1414, DMC-1415, DMC-1425, DMC-18X2, DMC-2100, 
and DMC-3425  controllers. 

Enable Control Characters 
When checked, this will enable the host computer to send control characters to the controller.  
Otherwise, the control characters will be sent to t he host computer instead.  For instance, a master reset 
is commanded to the controller with ^R^V.  However, if this ‘Enable Control Characters’ option is not 
checked, ^R^V would result in a windows command.  Typically, ^V is the windows command to paste 
from the clipboard. 

 

Motion Status Menu 
The following options are available under Motion Status menu:  
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Status on Axis 
The “Status on Axis” information provides the status of the switches and motor state for all axes on the 
controller.  This information is the same information provided by the tell switch command, TS, but is 
presented in a tabular format. 

System Overview 
The “System Overview” option provides information regarding the inputs (including limit switches, 
home switches, general use inputs, and analog inputs) for all axes.  In addition, the current position is 
also displayed.  This information is automatically updated on a continuous basis, providing a 
convenient form for monitoring the servo system. 

Editor 
To access the program editor, select the “Editor” button or type “ED” in the command line of the 
terminal.  This brings up a simple text editor best suited for smaller programs (under 500 lines).  Once 
a program is created, it can be downloaded to the controller using the “Download to Controller” option 
under the “File” menu.  Likewise, a program existing in the controller can be displayed by selecting 
“Upload from Controller” from the same menu. 

Logging 
Commands that are sent via the command line may be logged by clicking on “Start Log.”  To stop 
logging, click on “Stop Log.”  Once the logging is stopped, the information will be saved to a text file 
on the host computer, and the location of this file will be displayed in a message box like the one seen 
below.  Clicking on the “Clear Log” button will erase the information stored in the text file. 

 

 
  


